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Career and Objectives
10 Years diversified Experiencé\idrk Project teams to deliver IT solutions or manage high availability & co®plesatibn
Solutions in Airports and MOIs (Ministry of Interior) at KSA

Maximo Asset Management solution

C#.net, Ajax, JavaScript, XML, Web logics, Webserver 7.5, Administration of Webservers, WSDL

Search Engine Optimization Techniqgues Management ReptftiDdased software development Microsoft .NET Technol
(C#.NET & VB.NET & ASP.NET), XML Web Services, C++ Plan, organize, direct, control and evaluate the ope
information systems. Extensive experience in CMMS, HRMS, Open Text implenseipiaticd and system analysis

Skills in architecture design, installation, configuration and administration of Maximo Asset Management 7.5, Maxin
Framework (MIF), Maximo Develop and implement processes and procedures to ensure thad alsawiated notifications g
closed on time, with specific emphasis on Quality and Costs

Professional Projects Summary

UCC MakkahMOI Ministry of Interior Ja(KSA)

HTC (KAIA) King Abdul Aziz International Airport, Jeddah

OGDCL-UCH Project IBM MaximImplementation (Pakistan, Baluchistan)
ARAQA PalaceRi yadh Ministry of Interior (Kingds Sal mar
KSU King Saud Universities (All over the Kingdom) Ministry of Health
MOI- Riyadh Phas2 (Ministry of Interior Jail)

KASCH King AbdwAziz Specialized Children Hospitir(istry of Health)
DSS (Decision Support System) Portal for BTAM (SBG) Saudi Bin Ladin Group for Operation and Maintenance
SAPJ Architecture and Impleantation with Configuration

OracleERP (eAM) at KAIA Airport Implementation and Configuration of Flight Scheduling Management System
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Financial Reporting Management System for Business Intelligence Reporting (Bl Tools) Like Cognos from IBM
Configuratiorand Implementation of Reports Designing Tools
1 BIRT Tool for Reporting Management System, Hands on Experience for Developing as per Business Process

Organization
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IBM MAXIMO CALIBRATI ON

Calibration

Calibration Is the process of configuring an instrument to provide a tdeula
sample within an acceptable range. Eliminating or minimizing factors that cause
iInaccurate measurements is a fundamental aspect of instrumentation design.

ICON KEY

& Valuable

information

Instrument calibration is one of the primary processes used t 0
maintain instrument accuracy

What calibration can do for you?

Calibration is the activity of checking, by comparison with a standard, the accuracy of a
measuring instrument of any type. It may also include adjustment of the instrument to bring
it into alignment with the standard.

Calibrations are performed using only a few calibrators to establish the correlation at specific
LRAYGA SAUGKAY (GKS AyaldNdzySyadQa 2LISN) Ay 3
number of calibrators to establishtf@F £ A O N} G A2y NBf I GA2yaKALE
associated with preparing and testing a large number of calibrators might outweigh the
resulting level of performance




Ora-Tech Systems

What calibration can do for you ?

Caltraticy
History
Increase
Technicians
Productivity,
Improved
Data
Recording
Accuracy,

Ora-Tech Systems

IBM Focus & Commitment for a strong Calibration Solution:

* Calibrate Instrument, MT&E, Standards
* User-defined Calibration Data Sheets

* Fully 21 CFR Part 11 Compliant

» Calibration Job Plans & Job Plan Revision

* Calibration Intervals

« Calibration Work Orders
« Traceability & Reverse Traceability
* Loop Calibrations

* Calibration History




Calibration Functionality

Ora-Tech Systems

Features
Assets defined Tools defined  Asset Locations as Loop
as Calibration as M&TE Templates Tag lds Calibration
nstruments set-up
ustome: mnear and Repeatable EU %SPAN ) nand
jefined Non-Linear Test Points %URV Dynamic
resolution Instruments WREADING Checks
configurations
I KHOW Jverdue L Abilty to ent ax
nabied Standard Tolerar c et alr t
vahdatior Notificat Data it
: ':'n;“'\' Calibration Tool Usage Calibration Calibration Overdue
J Reports History Drift Errors Calibrations
7
Ora-Tech Systems
Calibration Functionality
« Set-up
Q Define Instruments and Standards <A.nat and Toolsl
Q Define Instruments Specifications < Data Sheets I Workflow
and
Escalation
Q Create Calibration Procedures < Job Plans ] Enabled
< < Preventative
Q Define Calibration Specific Intervals < Mai |
e
* Technician Work
Q Complete Calibration Work Orders <"""m”"‘"'| Workflow
and
Escalation
Q View Calibration History < Assets | Enabled




Cali bration Specific 0Sel ect A
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Asset Actions

The following Calibration specific actions are available from the Asset (Cal)
Select Action Menu:

Attach Data Sheet Template — Use to attach one or more data sheets to an
asset record.

View Cal%)ration History — Use to generate a list of calibration work
orders associated with the asset. You can also generate a list for a specific date
range.

View Tool Usage — Use to generate a list of all work orders that used a
specific M&TE or standard to calibrate an asset (reverse traceability). You can
also generate a list for a specific date range.

View Spot Check History — Use to view tool spot checks someone
performed on the current asset using the Tool Spot Check action in the Work
Order Tracking (Cal) Application. You can also generate a hst for a specific
date range.




Assets (Oil)

Query [=] Fing Asset

Qv |select Adion

FIPDE & @it mEy

BRI a8

(), Advanced Search w  [] SsveQuery v || Bookmars

Assets: Priter > Q- @&
Asset Desciption
»
Level Indicator Transmitter

Flow Indicator Transmitter

Flow Indicator Transmitter

Flow Indicator Transmitter

Flow Indicator Transmitter

Flow Indicator Transmitter

Pressure Indicator Transmitter

Pressure Indicator Transmitter

Pressure Indicator Transmitter

Pressure Indicator Transmitter

Level Indicator Transmitter

Flow Indicator Transmitter

Flow Indicator Transmitter

Flow Indicator Transmitter

Flow Indicator Transmitter

Flow Indicator Transmitter

Level Switch Low Low

300-LIT-012

200-FIT-D01A

200-FIT-001E

300-FITO01C

200-FIT-001D

300-FIT-002

200-FIT-052

200-FIT-082

210-FIT-052

210-FIT-082

210-LIT-012

310-FITO01A

OFITOONE

210-FITD01C

210-FIT-001D

210-FIT002

210-L5LL-003

INST

INST

INST.

INST

INST

INST

INST

INST

INST

INST

INST

INST

INST

INST

INST

Mogel/Type Last Reading Supplier Code

Bsnge Botary Equipment? Loop Locstion ls METE? Laliprstion? Sits

8 eem

OO0 D0 0 D0 D 0000000000
OO0 D0 0 D0 D000 00 0O00O 0pjd
HEEEEEEEEEEREEREES 3 E

[Select Records

Assets (Oil)

R R e — T R T N YY)
Gonfigure Topology Viewer E .
sset | SparzPats | Safety | Metde change ststs H Detils || Augits and Surveys H Gertifications H Work H Work Zones || Service Address || Regulations || Topology | Map ‘
Asset Details
Asset S - Site: Attachments
22821 | ) ved | &
Manage Dawntime History
Rotary Equipment? — K Type Moved?
INST
r Open Drilldown a L
Status: e S Asset Template: Calibration?
= e » 4
ciste Services
View » Returned To Vendor?
Unit of Measure and Conversion » r_
Enter Meter Readings
Details IMznage Meter Reading History =
ResetiReplace Meters
Parent Calendar:
‘ ‘ Move/Modify Assets oGDC-EQU Q
) Swap Assets _
Maintain Hierarchy? Shift:
O Issue Items from Storeroom p——
@) Associate Users and Custodians )
Location: Priority:
2001012 | 3> |Level Indication Transmitter E=piiee Gt
Ghange Item Number
Physical Location Serial #:
vewszsvx » [ Manage Asset Collectins
Attachment Libsary/Folders I3
Acea: Fallure Class:
ucHl x| Duplicate Asset »
Asset Service: Delete Asset i Type:
Add to Bockmarks
Manufsciurer View Tool Ussge Teo! Rate:
View Spot Ghedk History
Mosel Type View Asset Status History fe—
View Calibration History h e
' Attach Data Shests
Supplisr Coce: EWATEX Standard:
S e
Ranges Cognes Reparting
View Crew Assignments
javascript: void(0): v




Calibration Details in Asset

Internal Calibration?

%Reading

Steps to Encode Data in Asse€il)

& Selection of Most Critical Assets, related to the Instrumentation Section
which can cause the Failure of Specific Production Line.
Example:
Consider an Example of FIT (Flow Indicator Transmitter) atllUGH
DEHYTrainl (300-FIFO01A could be theCritical Asset which can cause
the Failure of this Train. Henceforth the Class of this Asset is set to be

Critical.
Class:
Class: CRITICAL
CRITICAL % Cperating Range From:

- .- - 0

To:

100
Units:

In H2O




Calibration:

¢tKS O2YLI NRazy 27
accuracy. The objective of calibration is to @ézis5
output properly corresponds to its applied input

Operating Range:

& From:Enter the minimum numeric value of the operating range of the
tool/Equipment This field is used in conjunction with the Operating
Range to field.

& To Enter the maximum numeric value of the operating range of the
tool. This field is used in conjunction with the Operating Range from

field.

& Selection of Units

Flow Indicator Transmitter:

Input Unit: inches of H20
Please See the below Image in order tesethe Right Input Unit for

the FIT

Select Value

+ Filter

Value

%

% VP
Deg C
Deg F
GPM

In H2O

Inches

RFM

Waolts

<

Description

Percent

% VP

Degrees ©

Degrees F

Gallons Per Minute
Inches of Water
Inches

Kilogram

Rotations Per Minute
Volts

British Thermal Units
Pounds

Milli Amps

Millimiter

Pounds per Square Inch

Ly Ay&aGNHZYSYdQa

0 KI G

Cancel

& % Span




& The Purpose of the Calibration is to ensure the input and output of an
instrument reliably correspond to one another throughout the entire
range of operation. We may express expectation in the form of a
graph, showing how the input and output of an instrumenshould
relate. Graph is linear in natein most of industries.

& This graph shows how any given percentage of input should
correspond to the same percentage of outf all the way from 0% to
100%. %Span +

& Things become more complicated when the input a &=
output axes are represented by units of measureme *-°°

100

other than the Percentage. Resding.
URV 100% =] wpplied As:
Output L
50%
LRV 0% . |
0% 50% 100%

LRV Input URV




% Applied ASEnter the direction of the accuracy fields (%Span,
%URYV, and Reading). Valid entries are-+and +#

Select Value e Bl

7 Filter > (0 R 3 1 2otz o = g

Value Desoiption

Plus di
Plus or Minus

Minus lied As:

®

Preparation / Considerationg Assets

1 Identify and build the Asset List assets that will go into Maximo those require
Calibration.

1 Depends on the amount ahstruments Category,funcions and points. This
document can serve as the input for creating the data in Maximo

1 If Maximo is akady in use for NOIalibrated Asets. Then you need to

transform your calibration assets to conform with Maximo best practices
(Guidelines, procedures)

" DataSheet Template

Juery [=] Find Data Shest Ciw Select Action +] Ij @ IE';] E:l

Q A dvances o Search | w ESave Guery w H Bookmarks

DataSheet - “FFter > (L 0 @ 5 0 4k 41t
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How to Prepare the Data Sheets?
Attached the Data Sheet to the Respective Asset/Locations

Attach Data Sheets

ﬂ To specify the data sheet you want to attach, type the necessary data for each
sheet. To refine your list, enter filter oriteria for the column{s) and press Enter or

click search.
W Filter » Q) 1-1cf1 Gl &
Data Sheet Desoription
I »
H2S_FIT_INS 3 Data Sheet of FIT at H25 Trains UCH-II {300/310) @

[

ﬂ To specify the data sheet you want to attach, type the necessary data for each
sheet. To refine your list, enter filter oriteria for the column{s) and press Enter or

click search.

W Filter > @, 1-10f1 o =

Cata Sheet Description
X

HZS FIT_INg 5, Data Sheetof FIT st H2S Trains UCHHI {300/310) ;@,
rl::b Select Value
¢ GuTcngatasr.aetTemplate | OK | | NewRow |

i 1

[*]|Find Dsta Sheet @ v |[Select Action F & & RS S
List | Dsts Sheet " Work Assets || Configuration |
Dats Sheet:
Data Shest of FIT at H2S Trains UCH-II (200/210) =l
Revision:

11



Attach Data Sheets
To specify the data sheet you want to attach, type the necessary data for each
sheet. To refine your list, enter filter oiteria for the column{s) and press Enter or
click search.
¥ Filter » O W 1-20f2 . =
Data Sheet Desoription
=
H2S_FIT_INS % Data Sheet of FIT at HZS Trains LCH-1I {300/310) a@.
A fh
© Select Value
# Filter > ©) e 1-40f4 o =

B |

Cata Sheet Cescription ’

H25_PT_INST_UCH-Il Data Sheet of PT-093 at H2S Train UCH-II {300/310)
HZ5_FIT_INST_UCH-Il Data Sheet of FIT at H2S Trains LCGH-I {300/310)
HZ5_PIT_INST_UGH-II Data Sheet of FIT at H2S Trains UGH-I {300/310)

H25_LIT_INST_UCH-II Data Sheet of LIT at H25 Trains UCH-11 {200,210}

Cancel

*  Valuable

information

Preparation / Cosiderations- Data Sheet
You can configure a data sheet for the following types of asset functions:

Analog asset functions

Discrete asset functions

Assets with multiple analog and discrete asset functions

Use the Data Sheet Template application tofpen the following functions:
Create data sheets

Associate work assets to a data sheet

Configure how values are formatted and saved

Find data sheet records

geegeeegeec
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*  Valuable

information

Preparation / Considerations Data Sheet

Define creating rangeof the Instruments (On Asset Master list)

w 5STAYS GKS DSYSNIt OFGS3I2NER 2F GKS Ay
w DI dAaS$s

w CSYLISNI GdzNBE ¢ NI yaYaididSNa

w {OFfSa

This grouping represents your instruments Assets. Data Sheet will be created per
grouping to allow datasheets toe shared among common categories.

w bdzYoSNAY3I F2NI S5 GF {KSSG ¢SYLX | GSa
w !dzi2z ydzYoSNJ @& {YI NI bdzyoSNJ
wDescription
Identify what the DS is performing Device, input Range, output range.
SCALE, 0To 10, KG, 0 To 10, KG

Retun || Return With Val

stststst

Create Data Sheet ID as Bflow Indicator Transmitter)
H2S_FIT_INST_UGH

Data Sheet of FIT at H2S Trains {GB00/310)
OGDCL

UCH

Data Sheet:
H2S FIT_INS

= =4 -8 8 A
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What is Data Sheet?

required.

application.

Data Sheet

Data sheets provide technicians with the information that they need to perform a
calibration. A data sheet is a template that defines the specifications of an asset for the
calibration process.

A data sheet defines the asset function specifications and the calibration point of an asset.
The data sheet also defines the functional checks and dynamics checks of an asset, if

Data sheets are associated with assets and are copied to calibration work orders for the
asset. On the work order data sheet, the technician enters calibration As Found and As Left
data. This data is used to analyze asset performance and calibration frequency.

The data sheet also records uncertainty measurement data for instruments and measuring
and test equipment (M&TE). This uncertainty data is calculated and imported from an
external source into the Data Sheet Template application and the Work Order Tracking

Ora-Tech Systems

Steps to Create Data Sheet

=4 =4 4 -5_9_-9_49_9_°2._-2_2°._-2._--2-

Data Sheet Name arldniquelD

Proper Description &ime of Data Sheet Clarify the Assets Data Sheet
SITEID §UCH (In Case of UCH SITE)
Encoding théJncertainty Data

K-Factor

Confidence_evel

Asset Functions

Type of Calibration

Input Units/Output Units

Input Information and Output Information
Scaling Factor

Tolerance

Calibration Points

14



Data Sheet Name with Unique ID

Diata Sheet “ Work Azsets H Configuration

Data Sheet: Crganization: Status:

H25_FIT_INST Data Sheet of FIT &t H2S Trains UCH-N (300/310) Lj’ o OGDCL Q APPR
Revizion: Site: Satus Date:

0 L:J' LcH @ e OB/O7 115 4:18 PM o
Aftachmerts
&
Uncertainty Data

ﬂ Uncertainty data is calculated by an external system. More information

System IDx
k-Factor;
1860 O
Confidence Level
8500 O

[ 2
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